
AD&D CD-ROM Core Rules User Guide

Overview:
This file is intended to be displayed at its maximum size. If it is not at this size, please 
maximize it (for Windows 3.1 users, left click on up arrow in top right of file, for Windows 95 
users, left click on box icon with heavy top border located at top of file near right corner).

You operate this program by using your mouse. You give most commands by moving the 
mouse pointer (cursor) over a gem and pressing the left mouse button. This is left clicking. 
Where you are told to left click on something, you are being told to move the mouse pointer 
over that something and press the left mouse button.

You can get information on what a particular command does or what to do on a particular 
screen by moving the mouse pointer over the text labels on the screen and pressing the right 
mouse button. This is right clicking.

The partial screen below illustrates a number of important points

The green gem next to the word “Roll” is the type of gem you left click on to give the program a 
command. The blue gems next to the dice are the types of gems you left click on to make a 
choice. In this illustration, the blue gem by the number 10 for Strength is dark as is the blue gem 
by the number 11 for Constitution. This shows that these are the numbers which have been 
selected. 



There is a box containing information on Strength. This box was brought up by right clicking 
on the word “Strength” just above it. To close these boxes, left click in them. Some boxes take 
up the entire screen. To close these types of boxes, left click on the word File which appears 
near the top left of the screen and then left click on the word Exit.
 
In the help box above, there is a word (STRENGTH) which is green and underlined. This 
means that this word can be used to jump to a different part of the program. To use this type of 
jump, move the mouse pointer over the green word (the pointer changes to become a picture 
of a hand) and left click.

Jumps like these are used throughout the program. The HYPERTEXT (HLP files) of the 
Books on Line use these extensively. The Table of Contents at the end of this section consists 
entirely of these hypertext jumps. To get information, left click on the green text for the 
information you want. To return to the Table of Contents after you have jumped, left click on 
the word Back which will be near the top left of the hypertext screen.

To exit the program, left click on the Exit -- Core Rules button on the Main Menu screen.

To get to the Main Menu screen from other parts of the program, left click on the Cancel 
and/or Close commands until the Main Menu screen appears.

Other Commands:
There are a number of other ways to make choices and give information to the program. Most 
of these are illustrated below:



The white boxes on the screen are Edit Boxes. You may type information into edit boxes. To do 
this left click on the box, type the information, and use the backspace key to remove any 
unwanted information. You do Not have to press the Enter key when you are done.

The Hit Point box and Age in Years: box are examples of Edit boxes.

The white boxes with down pointing arrows on their right are Combo boxes. Race, Class, and 
Alignment are examples of Combo boxes. To choose an item from a combo box, left click on 
the down arrow. The list of items from which you may choose appears. To choose an item, left 
click on it from this list. In the illustration, Chaotic Good has been chosen. After you make 
your choice, the list will go away and your choice will appear in the box.

The small up and down arrows which appear to the right of the white boxes under Ability 
Scores are Spin Buttons. Left clicking on the up arrow of a spin button will cause the number 
in the box next to it to increase. Left clicking on the down arrow of a spin button will cause 
the number in the box next to it to decrease.

You may type information into Combo boxes and Spin Button boxes if they are white. You 
may not type in information if a box is not white. The box under the word Total is an example 
of a box where you may not enter information.

There are three other ways to make choices and enter information. These are illustrated below.



The white box under Custom Monsters is an example of a List box. To choose an item from a 
List box, double left click on it. Double Left Click means move the mouse pointer over the item 
and click the left mouse button twice (rapidly). The buttons to the right of the list box: New, Edit 
and Delete are Label buttons. To choose (or press) a Label button, left click on it. 

Notice that each Label button has one letter underlined (the letter N in New, for example). 
When a letter is underlined like this, it means you can give this command by holding down the 
Alt key while pressing that letter on the keyboard. The commands in the Main Menu make 
extensive use of this.

If you are in the Player Character portion of the program, the Wizard, Finish, Cancel, Back, 
and Next commands appear on most screens. If you are at a point in the program where you 
can use these commands, they have a green gem next to them. If not, they have an empty box 
next to them. These commands operate as follows:

Wizard: left clicking on the Wizard button brings up an animated wizard who will give 
information (play a .wav audio file) about the current screen. To shut off the wizard while it is 
talking, left click on the Wizard button.

Finish: left clicking on this button saves your character in its current state and returns you to 
the Main Menu screen.

Cancel: left clicking on this button returns you to the Main Menu screen without saving any 
changes you have made to your character.



Back: left clicking on this button returns you to the previous screen (unless the previous screen 
was the Main Menu screen).

Next: left clicking on this button takes you to the next screen. Note that selecting certain 
commands will take you to the next screen immediately without your having to select this 
command.

Help Use:
If you want to refer to this guide while using the program, you may do so as follows:
Windows 95 users, while this file is open (now for example) left click on the Core Rules 

button in your start bar. This will return you to the Core Rules program. To call up these 
instructions, left click on the Instruct button on your start bar. You may use these two buttons 
to toggle between the program and these instructions

Windows 3.1 users, hold down the Alt key while pressing the Tab key while this file is 
open (now for example). This allows you toggle through all the programs you are running. 
You may use this Alt+Tab feature to move between the Core Rules program and these 
instructions.

Warning!!
Keeping this file open while running the program makes it more likely your system will 

run out of memory. This can cause the system to crash. If you are having memory problems, 
we do not recommend you keep this file open while running the program.

Please be aware that in addition to this file, the Map Maker, the Books on Line, and the 
files you jump to when you left click on a jump (green, underlined) word may also be kept 
open while this program is running. Whenever you open one of these files, be sure to close it 
when you leave. In most instances, you close these by using the Exit command from the File 
menu near the top left of the screen.
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Main Menu

This the first screen to appear after the title screen. On this screen, you choose what you want 
to do with the program.    The choices are:

Player character:
This portion of the program allows you to create a new character and add it to the 

database, enter an existing character into the database, take a character already in the database 
and update its information, and print out a character record.

Also under this heading is View Village Tour. The village tour is a special, animated, 
mini-AD&D adventure.

Books On Line:
This portion of the program provides reference material. The program provides 

information from five books: Player’s Handbook, Dungeon Master Guide, Monstrous Manual, 
Arms & Equipment Guide, and Tome of Magic. The text from these books is presented in two 
formats: Rich Text Format (.RTF) which allows you to enter the file into a word processor and 
edit it, print it, etc. as you would any other text file and Help Format which allows you to 
easily access information through Hypertext jumps.

Also provided in this section are Key Topics which provides information on a topic 
gathered from all five books and these Instructions.

DM Toolkit:
This portion of the program provides utilities designed to be used by Dungeon Masters 

in creating and maintaining a campaign. These are:
Handout Generator which allows you to read and manipulate the Rich Text Formats of 

the Books On Line and create handouts and other documents with special borders or over 
special backgrounds.

Map Maker which allows you to create maps on three different scales, place encounters 
on these maps, and (for the smallest scale) create 3D maps.

Treasure Generator which allows you to roll up individual and encounter treasure.
Monster Generator which allows you to access all monsters from the Monstrous Manual 

and create new, custom monsters.
NPC Generator which allows you to create Non-Player Characters with either full, 

Player Character-style records or abbreviated records suitable for encounters.
Encounter Generator which allows you to put monsters, NPCs, traps and treasure 

bundles into encounters.
Dice Rolls which allows you to have the program simulate dice rolls to your 

specifications.
Table Rolls which allows you to have the program roll the results from tables in the 

Player’s Handbook and Dungeon Master Guide.



You will return to this screen whenever the Cancel button is selected. You will sometimes 
return to this screen when the Close button is selected. Use the Exit – Core Rules button on 
this screen to exit the program

When you have selected an option on this screen, left click on the Next button to continue.



Player Character

The Player Character portion of the program provides the following options:

Generate New Character:
Select this command to create a new, AD&D Player Character. The program will walk 

you through the character creation process, keep track of the choices you make, the items you 
acquire, and do all calculations for you. At the end of the process, you can write a history for 
your character, select a portrait for character and save your character into the database.

Update & View Character:
Select this command to see your character record, print your character record, save your 

character to a disk, load a character from a disk into your database, or delete a character from 
your database.

Enter Existing Character:
Select this command to enter an existing character into the database. The program will 

provide templates for you to fill out and walk you through the process.

View Village Tour:
Select this command to see an original animated, mini-AD&D adventure created 

especially for this product. 



Generate New Character

This part of the program creates a new character for you. When you select this option, you are 
first taken to a screen where you select one of seven methods for creating a new character.

If you select methods II through VI, you are taken to a screen where you can generate your 
character’s ability scores. After doing this, use Next to go to the Character Selection screen 
(you automatically go to the Character Selection screen when you choose method I).

On this screen all the allowed race/class combinations for that character have a blue gem.    To 
select a race/class combination, left click on a blue gem and then left click on the Next button. 
To reroll the ability scores using Method I, left click on the Roll gem. To change the scores 
using another method, use the Back button.

If you select Method VII, you are immediately taken to a Character Selection screen where all 
the race/class combinations have blue gems. Left click on the gem for the character you want 
and the program will generate ability scores suitable for that character. When you have the 
character you want, left click on the Next button.

The next screen provides information about the character. You may change the character’s 
name, alignment, and gender on this screen. Left click on Next when you are ready to 
continue.

You may change the proficiencies the program has assigned your character on this screen. 
Single class fighters may also have their specialization changed. To delete a proficiency, 
double left click on it in the acquired box. To add a proficiency, double left click on it in the 
possible box. You will get the proficiency if you have the slots to pay for it.

If you would rather have Secondary Skills than Nonweapon Proficiencies, left click on the 
Secondary Skills gem at the bottom of the screen.

The screen you go to next depends on your character’s class. Fighters and priests go directly to 
the Armor screen. Wizards and rogues go to the Spells screen and Rogue skills screen 
respectively.

On the spells screen, the program has already chosen a list of spells for you and put these in a 
spell book. If you would like to change these spells, left click on the Clear button and then 
double left click on the spells you want your character to learn. When you are done with this 
screen, left click on the Next button.

On the Rogue Skills screen, the program has invested your character’s starting Rogue Skills 
points. To change how these points are used, use the spin buttons on the bottom of the screen. 
When the skills are as you want them, left click on the Next button.



The Armor screen allows you to select armor, shields, and helmets for your character. Unless 
your character is a wizard, the program will already have purchased something for your 
character. 

The list box at the top right of the screen shows the items which have been purchased on this 
screen. The list box at the bottom left of the screen shows all items which have been purchased 
for the character. 

To get rid of an item (sell it back), double left click on that item in the top right box. When an 
item is returned, your character’s money is returned.

To purchase an item, double left click on that item in the For Sale box in the middle of the 
screen. When an item is purchased, the cost of the item is deducted from your character’s 
money and the item appears in both the top right and bottom left boxes. If you attempt to 
purchase an item which is inappropriate for your character, the program will warn you.

Encumbrance information is given at the bottom right of the screen. Your character’s 
encumbrance and movement change as items are bought and sold. Left click on the Next 
button when you are finished with this screen.

The next screen is the Weapons screen. This screen operates identically to the Armor screen 
except you can purchase weapons instead of armor for your character. The weapons the 
program buys for your character depend on your character’s weapon proficiencies. Left click 
on the Next button when you are finished with this screen.

The next screen is the equipment screen where you may purchase equipment, goods, and 
services. Unlike the previous two screens, you must select a category of goods and services 
from the combo box located above the list box in the center of the screen. The items which 
appear in the list box depend on which category of goods and services have been selected in 
the combo box. When you are finished with this screen, left click on the Next button.

The Inventory screen has a different box for each category or location of item you have. If 
there is something in a box, there will be a small plus sign (+) in a smaller box to its left. Left 
click on the plus sign to display what is in the box.

You may move items around by dragging them into different boxes or containers. To drag an 
item, left click on it and hold the left mouse button down until you have moved that item over 
the desired box or container. When you release the left mouse button, the item will be in that 
box or container if that box or container can legitimately hold that item. (If you drag an item 
above or below the list box, the list will scroll).

Certain items, such as backpacks, are containers which can hold any item small enough to fit 



inside. Other items, such as scabbards or quivers, can only hold particular types of items 
(swords and arrows). 

At the right of the screen is information about the character’s movement rate, Armor Class, 
THAC0 (To Hit Armor Class 0), damage, etc.

Items which the character has carried, readied, or worn count against the character’s 
encumbrance and movement rate. For an item to affect the Character’s Armor Class, it must be 
worn. For an item to affect the character’s adjusted melee or missile THAC0 or adjusted 
damage, it must be readied. 

Left click on the Character History button to bring up a screen which permits you to create a 
history for your character and select a portrait. To enter a character history, left click on the 
white box beneath the Character History heading and enter the information. To select a 
portrait, left click on the Select a Bit Map button at the bottom right of the screen. A list box 
will appear with the names of all the bit map files in the portrait folder for this program. 
Double left click on one of these to assign it to your character. Note: you can create custom 
portraits for your character by creating bit maps and placing them in this folder. The file must 
have the .bmp extension and should be of the correct size to fit in the space provided.

When you are all done with your character, left click on the Finish button. The program will 
save your character to the database and return you to the Main Menu screen.



Update & View Character

When you select this option, a screen appears with a list box containing the characters in your 
database on the left and a number of command options on the right.

To select a character from the list box, left click on it.

View:
When you left click on the View option, a print preview screen for the selected character’s 
record appears. Use the Next and Prev page buttons to look through the record. To print out 
the record (character sheet), left click on the Print button. Note: this is the only place in the 
program where you can see all of your character’s finally adjusted numbers.

Destroy:
Left clicking on the Destroy command will remove the selected character’s record from the 
database.

Update:
Left clicking on Update will allow you to change most of the information in the character’s 
record. The information you can change directly is in white boxes. To change the character’s 
Experience Point Total, enter the amount of the change in the box under the word Add (this 
may be a positive or a negative number) and left click on the green gem between the two 
boxes. After you have finished changing information on the first screen, you may left click on 
the Finish button to save the character and return to the Main Menu screen, or you may left 
click on the Next button to go further into the program and make more changes.

Note: When your character goes up a level, you will be notified when he is eligible for more 
spells, proficiencies, etc. When this occurs, you should use Next to advance further into the 
program and get these for your character. You assign these in the same way used in Generate 
New Character.

Rogues:
It is particularly important to update rogues (thieves and bards). Use Next to get to the Rogue 
Skills screen. Use the spin buttons at the bottom of the page to invest the skill points.

Spells:
The Spells screen in Update contains a number of differences from the Spells screen in 
Generate. One of the differences is the combo box in the top left of the screen. The combo box 
allows you to select either a spell level your character can cast spells for or all spell levels your 
character can cast spells for. This selection determines which spells appear in the list boxes on 
the page.



If your character is a wizard, he will be able to create custom spells and new spell books. To 
create a custom spell, left click on the Custom Spell gem at the top right of the Spells screen. 
A box pops up with a list of existing custom spells on the left and command options on the 
right. The options are to create a New spell, Edit the selected existing spell, or Delete the 
selected existing spell.

When you create a new spell, you must assign it a level and name. You should also enter a 
description of what it does. The program will not allow you to assign the same name to more 
than one spell.

When you edit an existing spell, you can change its level and description, but not its name. 

When you delete a custom spell, it is removed from your database.

After you create a custom spell, it is placed in your list of    Magic Spells for a mage or in both 
the Specialist Spells and Secondary Spells list for a Specialist Wizard. If a specialist wizard 
wants to learn a custom spell as one of his Specialist Spells, he should double left click on the 
spell in the Specialist Spells list. If the specialist Wizard wants to learn the spell as a secondary 
spell, he should double left click on it in the Secondary Spells list.

When a wizard is generated by the program, he is provided with a spell book containing the 
spells he has learned. You may create more spells books by left clicking on the button (just 
below the Custom Spells button). This brings up a box with a list of current spell books on the 
left and command options on the right. To select a spell book, left click on it in the list.

To create a new spell book, left click on the New Spell Book … button. A box will pop up in 
which may name the new spell book and select its type: Standard Spell Book, Spell Scroll, or 
Traveling Spell Book. When you select OK, this spell book is added to the list.

Left clicking on the Delete Spell Book button, removes the selected spell book from the list 
and the database.

When you left click on the Select Spell Book button, the spell book you have selected is the 
one which appears on the Spells screen. You place spells in this book by double left clicking 
on the spells you know in the Magic Spells, Secondary Spells, or Specialist Spells list.

When your character goes up a level and is allowed to learn new spells, the first new spell he 
learns is placed in the spell book which is on the screen at the time. You may only place spells 
in spell books if your character has learned them. 

Priests:
If your character is a priest or a higher level paladin or ranger, you will go to a screen with 
priest and warrior spells on it. You use the list boxes on this page to show which spell(s) your 



character has memorized and how many of each. The number of times a spell is memorized 
appears to its left in the list box.

There is a combo box above the spell list boxes. Use this combo box to select either a spell 
level your character can cast spells for or all spell levels your character can cast spells for. This 
selection determines which spells appear in the list box.

To create a custom priest spell, left click on the Custom Spells gem at the bottom right of the 
screen. Custom priest spells are created, deleted, and edited in the same manner as custom 
wizard spells except there is no select spell book.

Items and Equipment:
The Armor screen in Update operates the same as the Armor screen in Generate except: there 
is no cost to “purchase” an item. You can choose from both normal and magic items. Left click 
on the blue gems to change the selection. You may create custom items by left clicking on the 
Custom button. Creating custom items is a little complicated and is explained elsewhere. 

The Weapons screen in Update operates in the same manner as the Armor screen in Update.

There are two Equipment screens in Update. The first screen provides non-magical equipment 
only. The second screen provides both Magical Items and Gems/Objects of Art. Use the blue 
gem to select between them. Use the combo box to select the category of Magical Items and 
Gems/Objects of Art you want. To add an item to your character’s inventory, double left click 
on it.

Inventory:
The Inventory screen operates as in Generate, except there is no Character History button. 
When you are finished updating your character, left click on the Finish button.

Import:
Left clicking on Import from disk allows you to take a character which has been saved to a 
disk by the Core Rules program and add that character to the database. A pop up window 
appears. Use this window to set the path to the drive that holds the disk which contains the file 
you want to add to the database. The program will check the disk for valid files which may be 
added to the database. These files will appear in a list box. Double left click on the file you 
want to add.

Export:
Left clicking on Export to disk allows you to save a character file to a floppy disk. This file 
may then be imported to the program on a different computer. A pop up window appears. Use 
this window to set the path that holds the disk you will be saving your character file to. Enter 
the name of the character as it appears in the (far left) list box in the edit box next to File name 
and left click on the Save button.



Close:
Left click on Close to return to the Main Menu.



Enter Existing Character

Use this command to enter a character you created without the program into the database. 
There are some restrictions on what characters can be entered. Only races, classes, alignment, 
etc. from the Player’s Handbook may be entered.

Enter the required information on the white boxes on the first screen. Use Next to advance 
through the program, making selections and filling in blanks as you go. This portion of the 
program operates in the same manner as the Update function in Update character.



View Village Tour

When you left click on this button, a box pops up that gives you the choice of seeing the 
movie in three different formats. Which format is best for you depends on your system and can 
only be determined by trial-and-error.

As a general guideline, if you have a Pentium system and are running Windows 95, you can 
probably view the movie at its highest quality level. If you have a 486 system and are running 
Windows 3.1, you will probably need to view the movie at a lower quality level.

After you    have selected the quality level, left click on the OK button to view the Village 
Tour. 



Books On Line

The Books On Line portion of the program provides the following options:

Key Topics:
Selecting this option brings up a help (hypertext) file of selected topics. The information 

on these topics has been compiled from the five books included in the product. It provides a 
convenient, single-location source for information.

Player’s Handbook:
The complete text of the Player’s Handbook is provided in two different formats. The 

Rich Text Format allows the text to be entered into a word processor and edited, printed out, or 
otherwise manipulated. 

The Hypertext or .HLP format allows you to quickly reach any chapter, heading or table 
in the book. Note: although you have the option of printing out material from the .HLP format, 
we recommend against it. It is very easy to unintentionally print out the entire file (book).

Dungeon Master Guide:
The complete text of the Dungeon Master Guide is provided in two different formats. 

The Rich Text Format allows the text to be entered into a word processor and edited, printed 
out, or otherwise manipulated. 

The Hypertext or .HLP format allows you to quickly reach any chapter, heading or table 
in the book. Note: although you have the option of printing out material from the .HLP format, 
we recommend against it. It is very easy to unintentionally print out the entire file (book).

Monstrous Manual:
The complete text of the Monstrous Manual is provided in two different formats. 

The Rich Text Format allows the text to be entered into a word processor and edited, printed 
out, or otherwise manipulated. 

The Hypertext or .HLP format allows you to quickly reach any monster. For your 
convenience, we have placed the index at the front of the file. Left click on the entries in the 
index to jump to the monsters. Note: although you have the option of printing out material 
from the .HLP format, we recommend against it. It is very easy to unintentionally print out the 
entire file (book).

Arms & Equipment Guide:
The complete text of the Arms & Equipment Guide is provided in two different formats. 

The Rich Text Format allows the text to be entered into a word processor and edited, printed 
out, or otherwise manipulated. 

The Hypertext or .HLP format allows you to quickly reach any chapter, heading or table 
in the book. Note: although you have the option of printing out material from the .HLP format, 
we recommend against it. It is very easy to unintentionally print out the entire file (book).



Tome of Magic:
The complete text of the Tome of Magic is provided in two different formats. The Rich 

Text Format allows the text to be entered into a word processor and edited, printed out, or 
otherwise manipulated. 

The Hypertext or .HLP format allows you to quickly reach any chapter, heading or table 
in the book. Note: although you have the option of printing out material from the .HLP format, 
we recommend against it. It is very easy to unintentionally print out the entire file (book).

Instructions:
This is the file you are now reading.



Key Topics

Left clicking on this gem brings up a large hypertext file which contains information on 
selected topics compiled from the five books contained in this product.

While we do not recommend printing out the hypertext files of any of the books, it is okay to 
print out the topics in Key Topics. If you print in Key Topics you will get a print out of the 
information you can scroll through on the screen. This is relatively short.

If you print out the hypertext file for any of the books, your computer and printer may attempt 
to print out the entire book.

To reach a topic, find it in the green, underlined text near the top of this file. Left clicking on 
this text will jump you to this topic. Left clicking on the Back button while it is active will 
return you to where you were before your most recent jump.

It is possible to have Key Topics open in the background while running other programs. This 
may cause memory problems and we recommend that you exit Key Topics using the Exit 
command from the File menu when you are through with it.



Player's Handbook

Left clicking on this gem pops up a menu that gives you the choice of receiving the text from 
the book in either a Rich Text (RFT) or Hypertext (HLP) format.

If you want the information to appear in the handouts generator, select the Rich Text Format. 
You may then treat it as any other word processing file. This format is also useful if you want 
to locate all instances of a certain word by using the Find command in the Edit menu.

If you would like to load this file into your own word processor, it is located in the Books 
folder (subdirectory) of the TSR folder (directory) on the CD. Remember that you will not be 
able to save any changes to the CD, so choose a different save folder (directory) if you edit 
this file.

If you want to use hypertext jumps to navigate through the material, select the Hypertext 
format. This format allows you to jump to a heading within the file by left clicking on the 
green, underlined heading in the Table of Contents or Index.

A word or warning, we had to bend some rules to get this file to behave this way. The HLP 
files are designed to present information in fairly small segments. It was not designed to 
accommodate books as one, big topic. For    this reason, we recommend you NOT use the print 
command. We are also reasonably sure you will be disappointed in the results of using the 
Find command from the Help Topics button.



Dungeon Master Guide

Left clicking on this gem pops up a menu that gives you the choice of receiving the text from 
the book in either a Rich Text (RFT) or Hypertext (HLP) format.

If you want the information to appear in the handouts generator, select the Rich Text Format. 
You may then treat it as any other word processing file. This format is also useful if you want 
to locate all instances of a certain word by using the Find command in the Edit menu.

If you would like to load this file into your own word processor, it is located in the Books 
folder (subdirectory) of the TSR folder (directory) on the CD. Remember that you will not be 
able to save any changes to the CD, so choose a different save folder (directory) if you edit 
this file.

If you want to use hypertext jumps to navigate through the material, select the Hypertext 
format. This format allows you to jump to a heading within the file by left clicking on the 
green, underlined heading in the Table of Contents or Index.

A word or warning, we had to bend some rules to get this file to behave this way. The HLP 
files are designed to present information in fairly small segments. It was not designed to 
accommodate books as one, big topic. For    this reason, we recommend you NOT use the print 
command. We are also reasonably sure you will be disappointed in the results of using the 
Find command from the Help Topics button.

Note: the pictures of the monsters are in the Monster Generator section of the DM Toolkit.



Monstrous Manual

Left clicking on this gem pops up a menu that gives you the choice of receiving the text from 
the book in either a Rich Text (RFT) or Hypertext (HLP) format.

If you want the information to appear in the handouts generator, select the Rich Text Format. 
You may then treat it as any other word processing file. This format is also useful if you want 
to locate all instances of a certain word by using the Find command in the Edit menu.

If you would like to load this file into your own word processor, it is located in the Books 
folder (subdirectory) of the TSR folder (directory) on the CD. Remember that you will not be 
able to save any changes to the CD, so choose a different save folder (directory) if you edit 
this file.

If you want to use hypertext jumps to navigate through the material, select the Hypertext 
format. This format allows you to jump to a heading within the file by left clicking on the 
green, underlined heading in the Table of Contents or Index.

A word or warning, we had to bend some rules to get this file to behave this way. The HLP 
files are designed to present information in fairly small segments. It was not designed to 
accommodate books as one, big topic. For    this reason, we recommend you NOT use the print 
command. We are also reasonably sure you will be disappointed in the results of using the 
Find command from the Help Topics button.



Arms & Equipment Guide

Left clicking on this gem pops up a menu that gives you the choice of receiving the text from 
the book in either a Rich Text (RFT) or Hypertext (HLP) format.

If you want the information to appear in the handouts generator, select the Rich Text Format. 
You may then treat it as any other word processing file. This format is also useful if you want 
to locate all instances of a certain word by using the Find command in the Edit menu.

If you would like to load this file into your own word processor, it is located in the Books 
folder (subdirectory) of the TSR folder (directory) on the CD. Remember that you will not be 
able to save any changes to the CD, so choose a different save folder (directory) if you edit 
this file.

If you want to use hypertext jumps to navigate through the material, select the Hypertext 
format. This format allows you to jump to a heading within the file by left clicking on the 
green, underlined heading in the Table of Contents or Index.

A word or warning, we had to bend some rules to get this file to behave this way. The HLP 
files are designed to present information in fairly small segments. It was not designed to 
accommodate books as one, big topic. For    this reason, we recommend you NOT use the print 
command. We are also reasonably sure you will be disappointed in the results of using the 
Find command from the Help Topics button.



Tome of Magic

Left clicking on this gem pops up a menu that gives you the choice of receiving the text from 
the book in either a Rich Text (RFT) or Hypertext (HLP) format.

If you want the information to appear in the handouts generator, select the Rich Text Format. 
You may then treat it as any other word processing file. This format is also useful if you want 
to locate all instances of a certain word by using the Find command in the Edit menu.

If you would like to load this file into your own word processor, it is located in the Books 
folder (subdirectory) of the TSR folder (directory) on the CD. Remember that you will not be 
able to save any changes to the CD, so choose a different save folder (directory) if you edit 
this file.

If you want to use hypertext jumps to navigate through the material, select the Hypertext 
format. This format allows you to jump to a heading within the file by left clicking on the 
green, underlined heading in the Table of Contents or Index.

A word or warning, we had to bend some rules to get this file to behave this way. The HLP 
files are designed to present information in fairly small segments. It was not designed to 
accommodate books as one, big topic. For    this reason, we recommend you NOT use the print 
command. We are also reasonably sure you will be disappointed in the results of using the 
Find command from the Help Topics button.



Instructions

This is the file you are in right now. If you are running Windows 95, you can access this file 
from outside the Core Rules program. If you are running Windows 3.1, you probably have to 
be running Core Rules to access this file.

You got to this topic by right clicking on its green, underlined name. To return from where you 
jump, left click on the Back button near the top left of the screen. To exit from this file, left 
click on the File menu at the top left of the screen and then left click on the Exit command.



DM Toolkit

The DM Toolkit portion of the program provides the following options:

Handout Generator:
This is a simple word processor. It can be launched independently of the program. If you 

are having memory problems, you should consider using this as a stand-alone program. You 
can do this from either the Core Rule program group in Windows 3.1 or the Core Rule 
command in the Start menu in Windows 95.

You can create documents with the Handout Generator. When you select a .RTF 
document from Books On Line, that document is presented through the Handout Generator.

The handout generator allows you to place text over bit mapped backgrounds or inside 
bit mapped borders. To select a background or border for your document, use the 
Background/Border button. This button is the furthest to the right in the illustration below.

Treasure Generator:
This utility creates treasure in accordance with Table 84 of the Dungeon Master Guide. 

The utility provides the total Experience Point and Gold Point values of the treasures 
generated. It allows you to accumulate treasures from roll to roll. It provides direct access to 
the monster database so you can call up treasures appropriate for selected monsters.

Monster Generator:
This utility provides a database of all monsters in the Dungeon Master Guide. It also 

provides a tool which allows you to create your own custom monsters and add them to the 



database. 

NPC Generator:
This utility allows you to create NPCs of the race, class, and level you specify. You may 

take the NPCs as generated or customize them. 

Encounter Generator:
This utility allows you to create encounter tables, generate encounters from the tables or 

for monsters you select, totals Experience Point and Gold Point values for the encounters, 
allows traps to be created and placed in encounters, and allows treasure bundles to be created 
and placed in the encounters. 

Map Maker:
This utility allows you to create maps by selecting terrain tiles and placing them on a 

blank map. It can be launched independently of the program. If you are having memory 
problems, you should consider using this as a stand-alone program. You can do this from 
either the Core Rule program group in Windows 3.1 or the Core Rule command in the Start 
menu in Windows 95.

Three different sets of tiles are provided: one for overland or state maps, one for creating maps 
of cities or towns, and one for creating maps of buildings or dungeons. The last map set ties 
directly into a 3D map viewer. You may place the encounters you create on these maps.

Dice Rolls:
This utility allows you to have the program simulate dice rolling. You specify the 

number and type of dice you want as well as any number to be added or subtracted from the 
dice total. The program generates random numbers which simulate dice rolling and modifies 
these numbers as per your instructions.

Table Rolls:
This utility allows you to select a table from the Player’s Handbook or Dungeon Master 

Guide and have the program randomly generate a result from it.



Handout Generator

Left clicking on this gem opens the Handout Generator. You may also open the Handout 
Generator from outside the program by: double left clicking on its icon in the program group 
for Core Rules in Windows 3.1 or left clicking on Start then Core Rules and then Handout in 
Windows 95.

If you are having memory problems, we recommend running the Handout Generator from 
outside of the program.

The handout generator is a simple word processing program. Its unusual feature is the ability 
to provide bit maps as backgrounds or borders for the text. To place one of the bit maps we 
supply in a document, open the document and left click on the Background/Border button 
located at the far right of the Format Bar.

A box pops up and displays four borders and two backgrounds. Left click on the one you want 
and it is placed in the document. Use the Print Preview command of the File menu (top left of 
screen) to see how your document will appear with the selected background or border. These 
do not otherwise appear on the screen. Warning: the background bit maps are very large and 
your printer may not have enough memory to handle them. 

To exit the Handout Generator, use the Exit command from the File menu. If you leave it 
open, it may cause memory problems.



Treasure Generator

Left clicking on one of the buttons A through Z causes the program to randomly generate a 
treasure as per Table 84 in the Dungeon Master Guide.

The total gold piece value of any gems and art generated appear in boxes in the top middle of 
the screen. The lists of all Art Items, Gems, and Magic Items are displayed at the bottom of the 
screen.

If the box next to Accumulate Rolls is checked, the treasure is accumulated from roll to roll. 
Otherwise, each roll replaces the previously generated treasure. The Total Treasure Types 
Rolled box shows each treasure type which has been rolled and how many times each has been 
rolled. This is significant only if the Accumulate Rolls box is checked.

The buttons at the top left of the screen give the following options:

Close: exits the Treasure Generator and returns you to the Main Menu.
Print: provides a printout of the treasure or accumulated treasures currently displayed on the 
screen.
Monsters: takes you to the Monster Generator where you may select a monster and left click 
on the add treasure button to randomly generate a treasure for the monster and make it part of 
the current treasure.
Reset All: removes all treasure from the screen.



Monster Generator

Brings up a screen with all monsters in the database displayed on the left of the screen. A 
picture of the currently selected monster appears on the right of the screen unless there is no 
currently selected monster or if there is no picture for that monster. In these cases, the cover of 
the Monstrous Manual appears instead.

To view information on a monster, left click on it and then left click on the View Info… 
button.

To create a new monster using an existing monster as a basis, select the existing monster you 
want to use and then left click on the Convert to Custom … button. A screen appears with 
information for the selected monster. Change the monster’s name and any other information 
you want to modify and left click on the OK button. The new monster will be added to your 
database.

Create Your Own Monster:
To create a custom monster, left click on the Custom button. A box appears showing the new 
and custom monsters in a list box on the left and commands on the right. To create a new 
custom monster, left click on the New button. A box appears with places for monster 
information. Provide the information, left click on the OK button, the monster will be added to 
the database and you will be returned to the previous box where the new monster’s name will 
appear in the list box. 

To edit a monster in the Create Your Own Monster … box, select the monster and then left 
click on the Edit button. When you have finished editing the monster, left click on the OK 
button. The edited information will be saved to the database.

To delete a monster in the Create Your Own Monster … box, select the monster and then left 
click on the Delete button. The monster will be deleted from the database.

To view information about a monster in the Create Your Own Monster … box. Select the 
monster and then left click on the View Info … button. Information on that monster will be 
displayed.

Left clicking on the Close button returns you to the Main Menu.



NPC Generator

The initial screen shows a list of NPCs you have created on the left of the screen. Beneath are 
the New and Print commands. To the right of the list are the View, Destroy, Update, Import, 
Export, and Close commands.

To create a new NPC, left click on the New button. A screen appears on which you may select 
the Race, Class, and Level(s) for the NPC. Once this is done, left click on the Next button. You 
are taken into Update character where you can modify the NPC or left click on the Finish 
button to have him saved as the computer created him.

Left clicking on the Print command at the bottom of the screen, will provide an abbreviated 
print out of the selected NPC(s). This abbreviated character record is designed for use in 
encounters.

Left clicking on View allows you to see the NPCs full character record. Choosing the print 
command while in View provides a full, PC-style character record print out.

Left clicking on Destroy removes the NPC from the database.

Left clicking on Update takes the selected character into the Update feature where information 
for that character may be modified as explained under Update Character.

Left clicking on Import allows you to copy a character from a floppy disk into your NPC 
database.

Left clicking on Export allows you to save your character to a floppy disk.

Left clicking on close returns you to the Main Menu screen.



Encounter Generator

The first screen to appear is divided into two parts. On the left side are the encounters you 
have created. On the right side are the encounter tables you have created.

Tables:
To create a new table, left click on the New button on the right side of the screen. A screen 
appears which allows you to design the table. One of the first things you should do is enter a 
name for the table. 

On the bottom of the screens are gems which allow you to set the filters for which monsters 
appear in the table, randomly create an encounter table based on the current information for 
this screen, randomly select a monster from the table, and create an encounter with a monster. 
On the left side of the screen are a number of boxes for encounter frequencies.

The first thing to do is to set the filters for the encounter. To set a range for the level of 
monsters you want in the encounter, left click on the Hit Dice Filter button. This pops up a box 
where you use spin buttons to set a range of Hit Dice (1 to 100) for the monsters which appear 
in the encounter. When this range is as you want it, left click on the OK button.

Next left click on the terrain filter. A screen appears which allows you to select what terrain 
types the encounter table is for. Only monsters suitable for the selected terrain types will 
appear. The default is all terrain types. To set this to no terrain type, left click on the Clear All 
button. You many left click on a box to select a single terrain type or left click on a button to 
select all terrain which falls into a broad category. When you have the terrain filters you want, 
left click on the OK button.

Next left click on the Activity Cycle button. Select the activity cycle you want and left click on 
OK.

If you left click on the Roll a New Table button now, the program will randomly generate a 
new program as per the filters you have selected and the frequencies shown on the left of the 
screen. If you had left clicked on this button before setting the filters, it would have randomly 
created a table using all monsters in the database.

If you want to create a custom table, left click on one of the boxes by the frequency ratings on 
the left side of the screen. A list of monsters appropriate for that frequency and the filters you 
have selected appears. Select the monster you want to put in the table and double left click on 
it to move it into the box next to the frequency.

Once you have a table, either random or custom, you may left click on Roll Monster to have 
the program randomly select a monster from the table (based on frequency). The name of the 
selected monster will flash and the box to its left is checked.



Once a monster is selected, you can have the program create an encounter for it by left 
clicking on the Generate Encounter button. A list of encounters suitable for the selected 
monsters is presented. Select the one you want and it is added to your encounter database. A 
screen appears which allows you to modify the encounter. You may modify it (how to do this 
is explained below) or you may accept it as is by left clicking on the OK button.

To generate encounters from existing tables, or to edit existing tables, first select the table 
name from the list on the Encounter Generator screen and then left click on the Select … 
button.

To delete an encounter table, select the table name from the list on the Encounter Generator 
screen and then left click on the Delete … button.

To print out a table, select the table name from the list on the Encounter Generator screen and 
then left click on the Print … button.

Encounters:
Encounters can be created either by the program through the Encounter Tables or by you 
through using the New button to the right of the Encounter list box. To create a new encounter, 
left click on the New button.

Main Monsters:
A master list of monsters appears. Either double left click on the monster you want to build the 
encounter around or left click on the Random button to have the program randomly select a 
monster for you.

The encounter screen appears. Information is provided as per what is in the database for that 
monster. To add more monsters of the same type to the encounter, left click on the Add button 
to the left of the list box which contains the master monster for the encounter. This brings up a 
screen where you can give the monster a weapon, modify its THAC0 and Armor Class and 
determine how many of this monster appears. When you are done, left click on OK and you 
will return to the Encounter screen with this monster’s name in the list box with the main 
monster.

Additional Monsters:
To add a different monster to the encounter, left click on the Add button to the left of the 
Additional Monsters list box. A screen will appear which contains a list of all available 
monsters. Left click on the monster you want and its name will appear in the Name box. If you 
want to give the monster special equipment or spells, first select a category from the Select 
Category combo box. Then select the particular item or spell from the list box which appears. 
The selected item or spell will appear in the list box to the right. You may select a PC-type 
class for the monster, determine the number of monsters to appear and their hit dice, and other 
information. You may enter a special treasure for them and assign a gold point value to that 



special treasure. When you are satisfied with the monster, left click on the OK button.

Use the Edit button next to the monster list boxes on the Encounter page to change the 
information for the selected monster. Use the Remove button next to the monster list boxes on 
the Encounter page to remove the selected monster from the encounter.

Traps:
To place traps in the encounter, left click on the Add button next to the Traps list box. The 
Traps List box appears. The top list box shows all traps you have placed in this encounter. The 
bottom list box shows all traps you have created. To delete a trap from the encounter, select the 
trap in the top list box and left click on the Delete gem. To add a trap to the encounter, select 
the trap in the bottom list box and then left click on the Select gem.

To create a new trap, left click on the New button next to the bottom list box. The Trap Detail 
box appears. Name the trap, specify the location of the trap (if applicable), enter the amount 
and type of damage the trap does, enter any modifiers for detecting the trap, enter the number 
of characters who will be affected by the trap, enter the saving throws for avoiding the trap, 
and enter any special effects of the trap. When you are satisfied with the trap, left click on the 
OK button. You are returned to the Traps List box and the trap appears in the list of Master 
Traps.

To edit a trap, left click on its name in the list of Master Traps and then left click on the Edit 
button.

To delete a trap, left click on its name in the list of Master Traps and then left click on the 
Delete button. The trap is removed from the database.

Items:
To add items to the encounter, left click on the Add button to the left of the Items list box. 
Enter the Item Name, the number of items appearing, and the gold piece value of each item 
and left click on the OK button. The item will appear in the Items list box.

To edit an item, left click on its name in the Items list box and left click on the Edit button next 
to this box. Change the information for the item and left click on OK.

To delete an item, left click on the item’s name in the Items list box and left click on the 
Delete button next to this box.

NPCs:
To add an NPC to the encounter, left click on the Add    button next to the NPC list box. A 
screen with all available NPCs will appear. Double left click on the desired NPC on this screen 
and left click on the Close button. You will be returned to the Encounter screen and the 
selected NPC will appear in the list box.



To delete an NPC from the encounter, left click on the NPC in the list box and then left click 
on the Remove button next to the list.

Treasure:
To view the encounter treasure, left click on the View Treasure button at the bottom of the 
screen. To roll new treasure for the encounter, left click on the Roll New Treasure button on 
the bottom of the screen.

To create a treasure bundle and put it in the encounter, left click on the Treasure Bundles 
button. The Treasure Bundles box appears.

To create a new bundle, left click on the New button. Give the new bundle an identifying 
name. Enter the number of each coin you want the treasure to include in the boxes on the right. 
Use the Magical and Nonmagical buttons in combination with the Select a Treasure Type … 
combo box to put specific items into the treasure. Left click on the Custom button to add 
custom items you have created to the treasure. To remove an item from the treasure bundle, 
select it and left click on the Drop button. When you are satisfied with the bundle, left click on 
Close.

You are returned to the first Treasure Bundles box. The treasure you have just created appears 
as a bundle which will be added to the encounter. It is also in the list box for all treasure 
bundles.

To change the information for a treasure bundle, select it and left click on the Edit button. To 
remove a bundle from the list, select it and left click on the Delete button. To remove bundles 
from the encounter, left click on the None button.



Map Maker

To create maps, left click on the tiles at the left of the screen and then place them on the map 
by left clicking where you want them to go.

To change the tile sets, left click on the combo box near the top left of the screen and select a 
different view.

To draw free hand, left click on the pencil in the toolbar above the map. Choose the pencil 
width by left clicking on the desired line in the box to the left of the map. Choose the color by 
left clicking in the desired color box at the bottom of the screen. To draw, move the pencil 
over the map while holding down the left mouse button.

You may create your own map tiles and use them in the program. The best way to do this is to 
load one of our tiles into a paint program and modify it.    The Map Maker can only use tiles 
which are in the CusIcons folder (subdirectory), in the Map folder (subdirectory) of the 
CoreRule folder (directory) located in the drive where you installed the Core Rules program. 
Do not place these tiles anywhere else. They will not work if you do. To access the custom 
tiles, left click on the Custom button and then left click on the file. 

You may look at a map created in the Building View from a 3D perspective. To do this, select 
the 3D Map command from the View menu at the top of the screen while the map maker is in 
Building View. 

Use the Save command from the File menu (top left of screen) to save maps you have created.

For more detailed instructions on how to use the Map Maker, left click on the Help button 
above the map.



Dice Rolls

This screen allows you to have the program simulate dice rolling per your specifications. You 
many choose any combination of dice to be rolled at a time.

Check a box under the Dice Type heading for each type of dice you want rolled. Enter the 
number of each dice type you want rolled in the appropriate box on the left of the screen. 
Enter any amounts you want added to a dice roll in the appropriate box to the right of the plus 
(+) sign. Enter any amount you want subtracted from the dice roll in the appropriate box to the 
right of the minus (-) sign.

Once you have set up the dice rolls the way you want, left click on the Roll button. The total 
for each dice roll is shown on the right of the screen. The total of all dice rolls is shown on the 
bottom right of the screen. 



Table Rolls

In the list box for either the Player’s Handbook tables    or the Dungeon Master Guide tables, 
left click on a table. Once the table is selected, left click on the Roll gem. 

The program will generate a result for that table and display it on the screen. Some tables 
require you to make additional choices before a result is generated.



Create Custom Items

This portion of the program is not designed for the casual user. Be careful when you use it. If 
you enter in bad information, something bad may happen at some point.

You create a custom item by left clicking on a Custom button on an Armor, Weapon, 
Equipment, or Magical Items and Gems/Objects of Art screen in Update or Enter character.

A screen pops up with the list of current custom items for the selected categories shown on the 
left of the screen. Command buttons are on the right of the screen. Right click on the screen 
background to receive help.

Create New Item:
Left click for either Magical Item or Nonmagical Item. Use the combo box to select the type 
of item you want to create.

Nonmagical Armor:
Give the armor a name, weight, gold piece value, and Armor type. The other 

information is optional. You can place information in any white box. Left click on the OK 
button to add the new armor to the database.

Magical Armor:
Give the armor a name, weight, XP (experience point) value, AC adjustment and Armor 

type. The other information is optional. Left click on the OK button to add the new armor to 
the database.

Nonmagical Weapon:
Give the weapon a name, weight, cost, hands needed, weapon type, weapon group, 

weapon size, speed factor, damage vs. S - M, damage vs L, and whether it is a melee weapon, 
missile weapon or both. The other information is optional. Left click on the OK button to add 
the new armor to the database.

Magical Weapon:
Give the weapon a name, weight, XP (experience point) value, To Hit Adjustment, To 

Damage Adjustment, hands needed, weapon type, weapon group, weapon size, speed factor, 
damage vs. S - M, damage vs L, and whether it is a melee weapon, missile weapon or both. 
The other information is optional. Left click on the OK button to add the new armor to the 
database.

Nonmagical Gems:
Give the item a name, weight, and cost. The other information is optional. Left click on 



the OK button to add the new armor to the database.

Nonmagical Items of At:
Give the item a name, weight, and cost. The other information is optional. Left click on 

the OK button to add the new armor to the database.

Nonmagical Equipment:
Give the item a name, weight, cost and equipment group. The other information is 

optional. Left click on the OK button to add the new armor to the database.

Magical Equipment:
From the combo box, choose one of the categories starting with Bags, Bottles, Pouches, 

Containers and ending with Wands. Give the item a name, weight, and XP (experience point) 
value. The other information is optional. Left click on the OK button to add the new armor to 
the database.

Edit Item:
Select an item from the list. Left click on the Edit button. Change existing information 

or enter new information on the screen which pops up. Select the OK button.

Delete Item:
Select an item from the list. Left click on the Delete button. The item is removed from 

the list and the database.



Trouble Shooting

The two most common problems reported with this program are screen resolution and 
inadequate memory. Inadequate memory may cause the program to run very slowly.

To use this program, your screen resolution must be set to 800x600 or higher. If it is not set to 
800x600 or higher, the program will not work.

The program uses virtual memory as well as RAM. Virtual memory requires hard drive space. 
If you do not have 20 or more megabytes of hard drive space free, you may not have enough 
virtual memory to run the program. The more RAM you have, the less virtual memory you 
need. The free hard drive space required also depends on how fragmented the available hard 
drive space is. One large amount of space is more useful than many small amounts of space.

If you have 8 megabytes of RAM and 20 megabytes of free hard drive space, you have enough 
memory to run the program, provided the program can get to it. This is normally not a 
problem in Windows 95 which has an excellent memory manager. It is more of a problem in 
Windows 3.1.

Windows 3.1 users may get static sound when running the Village Tour. If this occurs, it may 
be fixed by adding Buffers to the Config.sys.

If you require additional help, you may call (608) 827-5317 through November 15, 1996. The 
phone line is in operation on work days (not holidays and not weekends) from 9 a.m. to 5 p.m. 
After that date, you may call the number which was included in the product.




